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CHAPTER 3 WORKING WITH SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Drawings in Visio are based on shapes. Shapes are the objects you 
drag from a stencil and place on a drawing page. 

Shapes themselves are like mini drawings. They have been created 
using the basic tools in Visio and have been placed in special files 
called stencils. 

The shapes in the stencils are referred to as shapes masters and 
these have certain intelligence built into them to dictate how they 
will look and behave when you place them on a page. 

In this session you will: 

 learn how to place shapes from stencils 

 learn how to select shapes 

 learn how to resize shapes 

 learn how to move shapes 

 learn how to duplicate shapes 

 learn how to rotate and flip shapes 

 learn how to change the order of shapes 

 learn how to create a new shape from existing shapes 

 learn how to group and ungroup shapes 

 learn how to align shapes 

 learn how to distribute shapes 

 learn how to use snap and glue 

 learn how to use the dynamic grid. 

INFOCUS 

WPL_V503 
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PLACING SHAPES FROM A STENCIL 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise 

you MUST open the file V503 
Working With Shapes_1.vsd... 

 Click on the Walls, Doors and 
Windows stencil in the 
Shapes window to see its 
shapes 

 Hover over the “L” Room 
shape until the pointer appears 
as a four-headed arrow 

 Hold down the left mouse 
button and drag the shape 
onto the page 

 Release the mouse button to 
place the shape 

 Repeat the above steps to 
place the following shapes as 
shown 

Corner surface (Cubicles) 
Desk chair (Office Furniture) 
Telephone (Office Equipment) 

Things look a bit squishy at the 
moment, but you’ll soon fix it  

 

For Your Reference… 

To place a shape from a stencil: 

1. Locate the desired shape in the stencil 

2. Click on and drag the shape onto the 
drawing page 

3. Release the mouse button 

Handy to Know… 

 The shapes automatically snap to the grid 
lines as you drag them onto the drawing 
page. But this will only work if the Snap and 
Grid options are activated. To find these 
options, click on the dialog box launcher  
in the Visual Aids group on the View tab to 

open the Snap & Glue dialog box. 
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All Visio drawings are made up of shapes. These 
may be as simple as lines or more complex like 
office furniture. The easiest way to add shapes to 
a drawing is to drag a shape from a stencil onto 

the page. From there, you can modify the shape as 
required. If you can’t find the shape you need from 
the myriad of built-in stencils, you can draw it using 
the tools in the Tools group on the ribbon. 
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SELECTING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file or open the file V503 
Working With Shapes_2.vsd... 

 Ensure the Pointer tool  is 

selected in the Tools group on 
the Home tab, then click on 
the chair to select it 

 Press  and click on the 

telephone to select both the 
chair and phone 

Blue selection handles will 
appear and pink lines will 
appear around the individual 
shapes. Notice that the pink 
line is the darkest around the 
first shape you selected… 

 Click away from the shapes to 
deselect them, then click on 
Select in the Editing group 
and ensure the Area Select 
tool  is selected 

 Hover above and to the left of 
the desk, then drag to create a 
selection net around desk, 
phone and chair 

 Press  to deselect the 

shapes, then click on Select in 
the Editing group and select 
Select All 

All shapes on the drawing 
page will be selected. You 
could have also used the 

keyboard shortcut  +  

 

For Your Reference… 

To select shapes: 

 Click on a shape using the Pointer tool  

 Press  or  and click on multiple 

shapes 

 Click and drag a selection net around several 
shapes using the Area Select  
tool  

Handy to Know… 

 To deselect one shape when several are 
selected, press  and click on the 

unwanted shape. 

 If you want to add a shape to a selection that 
you’ve created using the Area Select tool, 
press  or  and click on the shape. 

 

1 

2 

Before you can do most things to shapes in a 
drawing – including formatting, moving, copying, 
rotating, resizing or aligning – you must first 
select the desired shapes. In Visio, you can 

select shapes one at a time using the Pointer tool 
which is selected by default, by area using the 
Area Select tool, with the Lasso Select tool, or 
you can select all shapes on the page.  

5 
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RESIZING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file V503 Working With 
Shapes_3.vsd... 

 Click on the L Room to select 
it, then drag the bottom (or 
top) right corner handle down 
(or up) and to the right until 
the office is 4000mm wide 

 Drag the middle bottom (or 
top) handle down (or up) until 
the office is 4000mm high 

This shape has two yellow 
diamond handles. These let 
you reshape the shape… 

 Drag the higher yellow handle 
until the top wall is 2300mm 
and then drag the lower 
yellow handle until the bottom 
vertical wall is 2200mm 

 Place a 2 seat sofa (Office 
Furniture) at the right end of 
the office, then click on Width 
in the status bar to open the 
Size & Position window 

 Type 750, press , type 

1500, press  to resize the 

sofa, then click on close  

to close the Size & Position 
window 

 Drag the left-most yellow 
diamond handle to make the 
back of the sofa slightly 
thinner 

 

For Your Reference… 

To resize a shape: 

1. Click on the shape to select it 

2. Drag a blue handle to the desired size, or 

 Click on Width in the status bar to open the 
Size & Position window and alter the Width 

and Height as desired, then press  

Handy to Know… 

 If you use the Size & Position window to 
resize shapes regularly, you should turn on 
AutoHide. To do this, click on Turn On 
AutoHide  in the Size & Position window. 

This window will then automatically display 
when you click on a shape and will minimise 
when all shapes are deselected. 
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When you place shapes on a page, they will draw 
at a standard size. Occasionally you may find 
that the size is perfect, but more often than not 
you will have to resize them. You can resize a 

shape using the mouse by dragging a corner 
handle. Alternatively, you can resize a shape 

accurately by using the Size & Position window. 
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MOVING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file V503 Working 
With Shapes_4.vsd... 

 Hover above and to the right 
of the desk chair, drag a 
selection net around the 
chair and desk, and then 
release the mouse button to 
select the shapes (including 
the telephone) 

Notice that all three of the 
shapes are surrounded by 
the pink selection lines… 

 Hover over the centre of the 
selected shapes until the 
pointer changes to a four-
headed arrow, then drag the 
shape down to the bottom 
left corner of the office 

 With the shape still selected, 
use the arrow keys on your 
keyboard to nudge the 
workstation so that it is 
positioned slightly out from 
the office corner 

 

For Your Reference… 

To move a shape: 

1. Select the shape/s 

2. Drag and drop in the new location 

 or 

 Press , ,  or  to nudge the shape/s 

into position 

Handy to Know… 

 To constrain the movement of the shapes to 
vertical or horizontal, hold down  while 

dragging the shapes.  

 To move the shapes to another page in the 
drawing, drag the shapes to a page tab. 

 To move a selected shape by 1 pixel, hold 
 and press an arrow key. 

 

1 
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As you build your drawing, you may find the need 
to move one or more shapes. You can move 
shapes using either the mouse or the arrow keys 
on the keyboard. The mouse is useful for moving 

shapes larger distances, such as moving them into 
approximately the correct position, and the arrow 
keys are useful for making smaller moves, such as 
nudging a shape to locate it accurately. 

Tip: You can move a shape to an exact X and Y co-ordinate based 
on the ruler measurents. Select the shape and open the Size & 
Position window by clicking on Width in the status bar, then type 
the desired values in X (horizontal ruler) and Y (vertical ruler). 
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DUPLICATING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file V503 Working 
With Shapes_5.vsd... 

 Place a Small plant from the 
Office Accessories stencil 
between the wall and the 
sofa, as shown 

 Press  +  to duplicate 

the selected shape 

Because this keyboard 
shortcut tends to be a 
standard Office shortcut, 
Visio does not include a 
Duplicate tool on the 
ribbon… 

 Move the duplicated plant to 
the position as shown, then 
deselect the shape 

With Snap enabled, it is very 
easy to ensure you position 
both plants at approximately 
the same distance from the 
walls 

 

For Your Reference… 

To duplicate a shape: 

1. Select the shape/s 

2. Press  +  

Handy to Know… 

 You can also use copy  and paste  to 

duplicate shapes. These tools are found in 
the Clipboard group on the Home tab. 

 You can duplicate more than one shape at 
once simply by selecting them and then 
applying the duplicate command. 

1 

2 

When you are building a drawing, you may often 
find that you need the same shape over and over 
again. Rather than placing it multiple times by 
dragging it from the stencil, you can duplicate it. 

And what’s even better, duplicating a shape makes 
an exact copy of the selected shape/s including all 
formatting, text content and other properties of the 
shape. 

3 
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ROTATING AND FLIPPING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Continue using the previous 

file or open the file V503 
Working With Shapes_6.vsd... 

 Click on the sofa, then click on 
Position  in the Arrange 

group and select Rotate 
Shapes > Flip Horizontal 

 Click on the chair to select it, 
then hover over the rotation 
handle at the top of the shape 

The pointer will appear as a 
rounded arrow… 

 Click on and drag the rotation 
handle down until the chair is 
facing into the desk 

 Place a Door (Walls, Doors 
and Windows stencil) at the 
right end of the top horizontal 
wall 

 Click on Angle in the status 
bar to open the Size & 
Position window, type 180 

and press , then close the 

window 

 Repeat step 1 to flip the door 
horizontally, then drag the 
yellow handle to reduce the 
swing angle of the door 

 Place a PC monitor and 
Keyboard (Office Equipment 
stencil) on the desk and using 
one of the above rotation 
methods, rotate them 45° 

 

For Your Reference… 

To rotate a selected shape: 

1. Drag the rotation handle or click on Angle in 
the status bar and alter Angle as desired 

To flip a selected shape: 

1. Click on Position  in the Arrange group 

and select Rotate Shapes > Flip Horizontal 

/ Flip Vertical 

Handy to Know… 

 You can rotate a selected shape in 90° 
increments by clicking on Position in the 
Arrange group and selecting Rotate Shapes 
> Rotate Right 90° / Rotate Left 90°. 

 When you rotate a shape using the rotation 
handle, the shape will snap to specific 
angles, such as 15°, 30°… or 10°, 20°… etc. 

2 
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When you place shapes on the drawing page, 
they will appear with a default angle of rotation. 
When this angle is not the angle you desire, you 
can quickly rotate a selected shape free-hand 

using the mouse and rotation handle or very 
accurately using the Size & Position window. You 
can also flip a selected shape either vertically or 
horizontally using the ribbon. 

The further you move the cursor from the selection while dragging 
the rotation handle, the finer the rotation increments to which the 
shape will snap. 
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ORDERING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file V503 Working With 
Shapes_7.vsd... 

 Move the chair so that it 
appears tucked realistically 
under the desk 

Because we placed the chair 
after the desk, the chair is 
overlapping the desk. To make 
this drawing realistic, we need 
to send this shape down or 
backwards in the stacking 
order… 

 Click on Send Backward  in 

the Arrange group 

If the chair happened to be 
‘sitting’ on top of both the desk 
and the keyboard, you could 
have either clicked on Send 
Backward twice to move it 
down two layers or you could 
have clicked on Send to Back 

. You can also move shapes 

up in the stacking order… 

 Click on the desk and then 
click on Bring Forward  

twice 

You can see only the keyboard 
now… 

 Click on Send Backward  

twice to correct the shapes 

 

For Your Reference… 

To change the stacking order of a shape: 

1. Click on the shape 

2. Click on Send Backward  or 

 Click on Send to Back  or 

 Click on Bring Forward  or 

 Click on Bring to Front  

Handy to Know… 

 If you are organised enough, you may be 
able to place your shapes so that their 
stacking order is correct. 

 Send Backward  and Bring Forward  

move a shape one step at a time, while Send 
to Back  and Bring to Front  move a 

shape to the bottom or the top of the stack. 

1 

2 

When you place shapes on a page, they are 
applied in the order in which you place them 
where the first placed shape is lowest in the 
stacking order and the most recently-placed 

shape is at the top of the stacking order. So, if you 
move the first shape that you placed on top of the 
final shape that you placed, areas of the first shape 
will be hidden by the final shape where it overlaps. 

3 

4 
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MERGING SHAPES TO CREATE NEW SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file V503 Working 
With Shapes_8.vsd... 

 Open the V503 Working 
With Shapes.vss stencil in 
the Shapes window 

 Right-click on V503 Working 
With Shapes.vss and select 
Edit Stencil to place it in edit 
mode 

 Drag a marquee to select the 
workstation, chair, PC 
monitor, keyboard and 
telephone 

 Press and hold down  

then drag the shapes into the 
Quick Shape area of the 
open stencil to create a new 
Master shape 

Pressing  copies the 

shapes to the stencil rather 
than moving them… 

 Double-click on the Master 
text, type My Workstation 

and press  to rename 

the shape 

 Save the stencil, turn off edit 
mode, then drag My 
Workstation into the top left 
corner of the office and rotate 
it so it faces the corner 

 

For Your Reference… 

To create a new shape from existing shapes: 

1. Open an editable stencil and place it in edit 
mode 

2. Select the shapes, press  and drag them 

into the stencil 

3. Rename the shape and save the stencil 

Handy to Know… 

 If you haven’t made your own custom 
stencils, you can simply create your new 
shape in the Favourites stencil. Follow the 
procedure in the exercise except that you 
must open the Favourites stencil. This 
stencil is stored in the My Shapes folder in 

the My Documents folder. 

4 5 

If you are creating a drawing where you are going 
to need multiple copies of groups of shapes, you 
have several ways in which you can deal with this 
situation. The least efficient method is to 

individually place each of the shapes many times 
over. Alternatively, you can create a new shape 
from the shapes and add it to either your own 
editable stencil or to the Favourites stencil. 

6 
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GROUPING AND UNGROUPING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file V503 Working With 
Shapes_9.vsd... 

 Select the sofa and two small 
plants 

The three shapes will be 
surrounded by pink lines… 

 Click on Group  in the 

Arrange group and select 
Group 

The pink lines will disappear 
leaving only the blue selection 
handles… 

 Use the arrow keys to move 
the grouped shapes a little 

The grouped shape is treated 
as one shape… 

 With the grouped shape 
selected, click on the sofa to 
select only that shape then 
click on Fill  in the Shape 

group to apply a fill to the sofa 

Let’s ungroup the shapes 
now… 

 Press  then click on the 

grouped shape again to select 
it  

 Click on Group  in the 

Arrange group and select 
Ungroup 

 

For Your Reference… 

To group shapes: 

1. Select the shapes to group 

2. Click on Group  and select Group 

To ungroup shapes: 

1. Select the group 

2. Click on Group  and select Ungroup 

Handy to Know… 

 You can add extra shapes to a group. After 
selecting the group, click on Group  and 

select Add to Group. And conversely, you 
can remove shapes from a group. Select the 
group and then click on the shape to be 
removed, then click on Group  and select 

Remove from Group. 

2 

4 

You can join several shapes together to form a 
group. A group is treated as a single shape and 
can be moved, formatted and resized like other 
shapes. Individual shapes in a group can still be 

selected and modified, but by grouping shapes you 
ensure that the placement of the objects in the 
group is preserved. Ungrouping a shape will 
change the group back into individual shapes. 

6 
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ALIGNING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise you 

MUST open V503 Working With 
Shapes_10.vsd... 

 Click on the top right chair – it’s 
neatly pushed under the table 

Let’s align the top four chairs to the 
bottom of this chair – this is the 
reference shape… 

 Press  and click on the other 

three chairs to select them 

The pink lines around the reference 
shape are dark pink… 

 Click on Position  and select 

Align Bottom 

 Move the bottom left chair up so 
that it appears pushed under the 
table like the top chairs 

 Press  and click on the other 

three chairs, then click on Position 
 and select Align Top 

Finally, let’s centre the table lamp 
both horizontally and vertically with 
the table… 

 Click on the table, press  and 

then click on the lamp 

 Click on Position  and select 

Align Middle, then click on 

Position  and select Align 

Centre, then deselect the shapes 
to see the result 

It’s looking better 

 

For Your Reference… 

To align shapes: 

1. Select the reference shape, press  and 

then select the other shapes to be aligned 

2. Click on Position  in the Arrange group 

3. Select the desired alignment option 

Handy to Know… 

 Live Preview is available for the alignment 
options. This lets you preview the result of 
each of the alignment options before 
applying one. 

2 
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When you place shapes on a drawing page, it is 
not always possible to align them accurately. 
Drawings look more appealing if the shapes are 
aligned carefully. In Visio you can align shapes 

horizontally and/or vertically along their edges or 
through their centres. When selecting the shapes to 
align, the first shape you select becomes the 
reference point to which the other shapes will align. 

7 
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DISTRIBUTING SHAPES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file V503 Working With 
Shapes_11.vsd... 

 Using the arrow keys, move 
the top left chair until its left 
side lines up with the 2000mm 
grid line 

 Move the top right chair until 
its right side lines up with the 
5500mm grid line 

Now you’ve set up the two 
shapes between which you will 
distribute the other two 
chairs… 

 Select the four top chairs, then 
click on Position  and 

select Space Shapes > 
Distribute Horizontally 

Now for the bottom chairs… 

 Click on the top left chair, 
press  and click on the 

bottom left chair, then click on 
Position  and select Align 

Right 

 Repeat step 4 to right-align the 
bottom right chair with the top 
right chair 

 Repeat step 3 to horizontally 
distribute the four bottom 
chairs 

 

For Your Reference… 

To distribute shapes: 

1. Position the start and end shapes, then 
select them and the other shapes to be 
distributed 

2. Click on Position  and select Space 

Shapes 

3. Select the desired distribution option 

Handy to Know… 

 Visio provides more distribution options than 
the two options shown on the Space Shapes 
submenu. Click on Position  and select 

Space Shapes > More Distribute Options 
to open the Distribute Shapes dialog box. 

 You must select more than two shapes to 
use the distribution commands. 

2 
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To improve the appearance of your drawing, you 
may need to distribute the shapes. This process 
evenly adjusts the spacing between the selected 
shapes – the two end shapes aren’t moved, only 

the shapes in between. This is a great time saver 
as you can quickly place all shapes on the page, 
move the start and end shapes into the desired 
location, and select and distribute the shapes. 

6 
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USING SNAP AND GLUE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise you 

MUST open V503 Working With 
Shapes_12.vsd... 

 Hover over the horizontal ruler at 
the top of the page until the 
pointer appears as a double arrow 

 Click and drag down to about half 
way between the first and second 
chairs 

This creates a guide to which you 
will align and glue the chairs… 

 Drag the left chair slightly to the 
right – it will ‘snap’ to the next grid 
line 

 Drag the left chair up to the blue 
guide 

A red square will appear when it 
can be glued to the guide…  

 Repeat the above steps to snap 
the right chair to the 5500mm grid 
line and glue the three chairs to 
the guide, and then distribute the 
four chairs horizontally 

 Hover over the guide until the 
pointer appears as a double 
arrow, then drag it down towards 
the table 

The chairs will move with the 
guide … 

 Repeat the above steps to glue 
the bottom four chairs to another 
guide, then move it as shown 

 

For Your Reference… 

To glue shapes to a guide: 

1. Hover over either ruler and drag out a guide 
to the desired location 

2. Drag to glue the shapes to the guide  

Handy to Know… 

 You can specify to which item shapes will 
snap and glue (e.g. guides, connection 
points etc) and set the snap strength (where 
1 is the weakest and 30 is the strongest) in 
the Snap & Glue dialog box. To open this 
dialog box, click on the dialog box launcher 

 for Visual Aids on the View tab. 

 

1 

2 

As you move shapes on a page, they tend to be 
attracted, or snap, to guides, grid lines and ruler 
marks. This helps you to align shapes accurately 
and quickly. You can also choose to fasten, or 

glue, shapes to guides or other shapes. This helps 
you to not only align shapes, but to move them as a 
group if necessary by, say, simply moving the 
guide to which they are glued. 

4 
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USING THE DYNAMIC GRID 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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 Before starting this exercise 

you MUST open V503 Working 
With Shapes_13.vsd... 

 Click on the View tab and 
ensure Dynamic Grid is ticked 
in the Visual Aids group 

 Drag a Decision shape (Basic 
Flowchart Shapes stencil) to 
the right of the Process shape 

The red alignment guide 
through the centre of the 
shapes shows that they are 
perfectly aligned. The spacing 
guide (red double-headed 
arrow) appears below the 
shapes… 

 Drag a Process shape to the 
right of the Decision shape 
until the alignment guide and 
two spacing guides appear as 
shown 

The alignment and spacing is 
perfect so far… 

 Drag a Process shape below 
the Decision shape until the 
alignment guide and spacing 
guide appears, as shown 

The centres of the Decision 
and Process shapes are 
aligned and the spacing is 
identical to the spacing 
between the other shapes in 
the drawing 

 

For Your Reference… 

To use the dynamic grid: 

1. Tick Dynamic Grid in the Visual Aids group 
on the View tab 

2. Drag the first shape into position 

3. Drag more shapes until the red alignment 
guide appears at the desired alignment and 
the red spacing guides appear 

Handy to Know… 

 Dynamic Grid is not turned on by default for 
all templates – it is, however, turned on for all 
drawings based on the flowchart templates. 
To turn dynamic grid on or off, click on 
Dynamic Grid in the Visual Aids group on 
the View tab. 

 

2 

3 

The Dynamic Grid feature displays a set of 
guides when you move a shape near another 
shape, page margin or container. Alignment 
guides appear when the centres of shapes align 

and spacing guides appear when the spacing 
matches that of other nearby shapes. When 
shapes are different sizes, guides also appear 
when matching edges align, such as the tops. 

4 

You can adjust the snap strength for the dynamic grid. To do this, 
click on the dialog box launcher  for Visual Aids (View tab), 
click on the Advanced tab and adjust the Grid snap strength. 


